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For Products Purchased in Canada (English)

(Standard Retail and OEM Limited Warranty and License Agreement for Novell Applications Products)

Limited Warranty
This Software is licensed AS IS. If for any reason you are
dissatisfied with the Software, return it with the package and proof of
purchase to your reseller within 90 days of the date of purchase for a
full refund. This refund is not available if you received the Software
as part of a Novell/Original Equipment Manufacturer bundle. If any
materials or media in this package are defective, return them to
Novell within 90 days of the date of purchase and they will be
replaced at no charge.

THE SOFTWARE IS NOT WARRANTED FOR USE ON
SYSTEMS WITH WHICH IT IS NOT COMPATIBLE. NOVELL
MAKES NO WARRANTY OR REPRESENTATION NOT SET
FORTH IN THIS LIMITED WARRANTY. NOVELL DISCLAIMS
ALL IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. NOVELL DOES
NOT WARRANT THAT THE SOFTWARE AND
DOCUMENTATION ARE WITHOUT DEFECT. NOVELL'S
LIABILITY ARISING FROM YOUR USE OF THE SOFTWARE,
DOCUMENTATION, OR RELATED SERVICES IS LIMITED TO
YOUR PURCHASE PRICE. NEITHER NOVELL NOR ANY OF
ITS LICENSORS SHALL BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE
DAMAGES. NEITHER NOVELL NOR ANY OF ITS LICENSORS
IS RESPONSIBLE FOR LOST PROFITS OR DATA OR FOR
BUSINESS INTERRUPTION.

Some jurisdictions do not allow limiting implied warranties or
liability for incidental or consequential damages, and some have
consumer protection laws which may supersede these limitations. As
a result, these limitations may not apply to you.

Novell Software License Agreement
The Novell software program(s) and documentation ("Software" and
"Documentation") for which you have purchased a license are
protected by copyright laws and international treaties and your use of
them is subject to the terms of this License. Novell software
programs are used in various ways and require different license
rights. The type of license that applies depends on the program for
which you purchased a license as shown on your Proof of Purchase
and the definitions and grants of license below. If the Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both at the same time. This License supersedes any prior version
license. This License is granted by Novell Ireland Software Ltd. for
products purchased in Europe, the Middle East and Africa, and by
Novell, Inc. for products purchased elsewhere. Each is referred to in
this License as “Novell”.

You may use the Software listed on the Proof of Purchase you have
received or will receive subject to and only in the manner described
in this License. If you purchased a license for multiple programs,
such as in PerfectOffice Standard, PerfectOffice Professional, or in
PerfectOffice Select, you have a single license covering those
programs and you may not separate them among multiple users. You
may make an archival copy of the Software for each license. For
each license obtained under this Agreement, you are authorized to
use either the Canada—English or the Canada—French version of
the software, or both, in support of a single user at any one time.
Software and documentation for both language versions may be
obtained by contacting Novell, Inc., at the address listed below.

For AppWare: You may (a) make and use up to the number of
copies indicated on your Proof of Purchase, (b) use Sample Files to
develop, copy and distribute AppWare applications, provided they
are substantially more robust and have substantially greater

functionality than the Sample Files, and (c) distribute ALMs that are
necessary for those AppWare applications solely in conjunction with
the applications, provided (i) you do not use the logo, name or
trademarks of Novell or the owner of the ALMs, (ii) include a valid
copyright notice on media containing the applications, (iii) you agree
to indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the applications, and (iv)
none of the applications you distribute substantially competes with
the AppWare. You may not copy or distribute any other files,
including Sample Files, Help Files, Header Files, Project Files,
Configuration Files, Miscellaneous Files or Other Development
Tools (all as defined in the AppWare Documentation). You may not
copy and distribute any of the AppWare Documentation.

For Envoy: With the purchase of a license for Envoy, you may
make and use up to the number of copies of the Envoy Driver
indicated on your Proof of Purchase. You may also freely distribute
the Envoy Viewer (“Runtime Viewer or Distributable Viewer”) with
an Envoy file developed using the Envoy Driver, provided you (a) do
not use the logo, name or trademarks of Novell, (b) include a valid
copyright notice on media containing the Viewer, and (c) agree to
indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the Viewer as part of the
Envoy file you distribute. "Envoy Driver" means the Driver that
enables you to create Envoy files from within other applications.
"Envoy Distributable Viewer" means the viewer that allows you to
view and manipulate the Envoy file. "Envoy Runtime Viewer"
means the viewer that, when bound to an Envoy file, enables you to
view the Envoy file. You are responsible for all primary technical
support to the end-user of any Viewer you distribute.

For GroupWise Client Software: You may use the Software in the
quantity and on the platform(s) listed on the Proof of Purchase. For
computers or workstations attached to a network, the quantity of
Software "in use" is the number of user mailboxes that you have or
intend to have on your network. For computers or workstations
attached to a public messaging system, the quantity of the Software
"in use" is considered to be the greater of (i) the maximum number of
computers on which the Software is loaded in memory or virtual
memory (“Loaded”), or (ii) the maximum number of computers on
which the Software is stored, for example, on a hard disk or other
storage device (“Stored”) at any one time. In addition, a GroupWise
Client license includes the right to access SoftSolutions via a
SoftWolutions Remote Document Server.

For GroupWise Message Server Software: Message Server
Software which you run on a computer, workstation, or file server
used as a message server requires a single license for as many
computers as necessary within a single domain. A "domain" is a
logical grouping of post offices and/or gateways serviced by a single
message server.

For GroupWise Gateway Software: Gateway Software is
considered "in use" when any portion of it is either loaded in memory
or virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

For SoftSolutions: You may install the Software on a single-user
computer or on a single terminal or workstation of a multi-user
computer or local/wide area network. Each copy of the Software
must be separately licensed whether executing from or residing on a
host computer, memory, or a Portable Mode Enabled computer; or
stored on a storage device of any kind, on multi-user computer(s),
single-user computer(s), or local/wide area networks (servers and
workstations/clients). In addition, a license is required for each
computer that accesses the Software via a SoftSolutions Remote
Document Server. You may use the Software in only a single
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environment (Windows or DOS) at a time. A Server Enhancement
Module (SEM) license is required for each File Server license,
notwithstanding that a copy of the SEM needs to be loaded for each
Dataset and a single set of SoftSolutions program files may access
multiple Datasets.

For Any Other Novell Applications Software Products: You may
use the Software in the quantity and on the platform(s) listed on the
Proof of Purchase. For a single-user computer or workstation not
attached to a network, the Software is considered "in use" when any
portion of it is either Loaded or Stored. For single-user computers or
workstations attached to a network, the quantity of the Software "in
use" is the greater of (i) the maximum number of computers on
which the Software is Loaded at any one time, or (ii) the maximum
number of computers on which the Software is Stored. On a multi-
user computer, the quantity of Software "in use" is the maximum
number of sessions executed at any one time.

General
Documentation, Home and Portable Use: You may make copies of
the Documentation to support your authorized use of the Software.
You may use a copy of the Software on a home or portable computer
if that copy is never Loaded at the same time it is Loaded on your
primary computer. This home or portable use provision does not
apply if you licensed this Software under an education or charitable
institution pricing program.

Restrictions. You may not rent, lease, decompile, disassemble,
reverse engineer, or create derivative works of the Software.
Irrespective of the number of sets of media included with the
Software, you may use the Software only as provided in this License
and the Proof of Purchase. Certain qualifications may apply to the
purchase of this License. When present, they are printed on the
Software package and form part of this License. If you breach any of
the terms of this License, it automatically terminates and you must
destroy all copies of the Software and Documentation. You may
permanently transfer the Software and Documentation only if all
copies, including prior and updated versions, are transferred together
and the transferee agrees to the terms of this License.

If you have any questions about this License or special programs for
education or charitable organizations, please contact the Novell Sales
Center, 1555 N. Technology Way, Orem, UT 84057-2399 or contact
your local Novell office or authorized Reseller.
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Pour les produits achetés au Canada (Français)

(Limitations de responsabilités et Contrat de concession standard des détaillants
et constructeurs OEM relatifs aux droits d'utilisation des produits d'application Novell)

Limitations de responsabilités
Ce Logiciel vous est concédé en licence EN L'ÉTAT. Si pour une
raison quelconque, vous n'êtes pas satisfait, vous disposez d'un délai
de 90 jours, à compter de la date d'achat, pour retourner, à votre
revendeur, le Logiciel et son emballage accompagnés du justificatif
d'achat pour en obtenir le remboursement intégral. En revanche,
aucun remboursement ne peut être accordé si le Logiciel a été acquis
dans le cadre du programme d'achat Novell/Original Equipment
Manufacturer. En outre, Novell s'engage à remplacer gratuitement
tout matériel ou support défectueux contenu dans l'emballage, à
condition qu'il lui soit retourné dans un délai de 90 jours à compter
de la date d'achat.

LE LOGICIEL N'EST PAS GARANTI POUR UNE UTILISATION
SUR DES SYSTÈMES NON COMPATIBLES. NOVELL
DÉCLINE TOUTE RESPONSABILITÉ POUR LES ÉLÉMENTS
NON INCLUS DANS LES PRÉSENTES LIMITATIONS DE
RESPONSABILITÉS. TOUTE GARANTIE IMPLICITE
D'APTITUDE À LA COMMERCIALISATION OU D'APTITUDE
À UNE UTILISATION PARTICULIÈRE EST EXPRESSEMENT
EXCLUE. EN AUCUN CAS, NOVELL NE GARANTIT QUE LE
LOGICIEL ET LA DOCUMENTATION NE PRÉSENTENT
AUCUN DÉFAUT. LA RESPONSABILITÉ DE NOVELL
DÉCOULANT DE L'UTILISATION DU LOGICIEL, DE LA
DOCUMENTATION OU DES SERVICES Y AFFÉRENTS NE
POURRA EXCÉDER LE PRIX D'ACHAT. EN AUCUN CAS,
NOVELL OU L'UN DE SES BAILLEURS DE LICENCES NE
SAURAIENT ÊTRE TENUS RESPONSABLES DES DOMMAGES
PARTICULIERS INDIRECTS OU ACCESSOIRES, OU DE
QUELQUE NATURE QUE CE SOIT, Y COMPRIS LA PERTE DE
PROFIT, DE BÉNÉFICE OU DE DONNÉES, OU
L'INTERRUPTION D'ACTIVITÉ.

Certaines juridictions ne permettent pas l'exclusion ou la limitation
de garantie implicite, ou la limitation de responsabilité pour des
dommages indirects ou accessoires. En outre, certaines juridictions
prévoient des dispositions particulières relatives à la protection du
consommateur, lesquelles pourraient annuler et remplacer les
présentes dispositions. En conséquence, la limitation de
responsabilité peut ne pas vous être applicable.

Contrat de concession du droit d'utilisation du Logiciel
Novell
Le ou les programmes logiciels, et la documentation Novell
(« Logiciel » et « Documentation »), pour lesquels vous avez acquis
une licence sont protégés par des lois et des traités internationaux
relatifs aux droits d'auteur, et leur utilisation est soumise aux termes
du présent Contrat de concession. Les programmes logiciels Novell
sont utilisés sous de nombreuses formes et sont soumis à des droits
d'utilisation différents. Le type de contrat de concession applicable
dépend du programme pour lequel vous avez acheté une licence,
spécifié par le justificatif d'achat, et les définitions et les octrois de
licence ci-dessous. Si le Logiciel constitue une mise à jour d'une
version précédente d'un logiciel Novell, Novell vous concède le droit
d'utiliser la présente version ou la version précédente du Logiciel,
mais non les deux simultanément. Dans ce cas, le présent Contrat de
concession annule et remplace tout contrat antérieur. Le présent
Contrat de concession est octroyé par Novell Ireland Software Ltd.
pour les produits achetés en Europe, au Moyen-Orient ou en Afrique,
et par Novell, Inc. pour les produits achetés ailleurs. Dans le présent
Contrat, chacun d'entre eux est désigné par « Novell ».

Vous êtes autorisé à utiliser le Logiciel spécifié sur le justificatif
d'achat que vous possédez ou que vous allez recevoir aux seules

conditions décrites dans le présent Contrat. Si vous avez acheté une
licence pour plusieurs programmes, comme stipulé dans
PerfectOffice Standard, PerfectOffice Professional ou PerfectOffice
Select, ladite licence couvre tous ces programmes et vous n'êtes pas
autorisé à les séparer entre plusieurs utilisateurs. Vous pouvez
réaliser une copie d'archive du Logiciel pour chaque licence. Pour
chaque licence obtenue dans le cadre du présent Contrat, l'acheteur
d'un produit canadien est autorisé à utiliser successivement la version
française et la version anglaise du Logiciel sur une machine donnée.
Le Logiciel et la Documentation de la deuxième version linguistique
peuvent être obtenus auprès de votre revendeur local ou en contactant
le siège de Novell à l'adresse indiquée à la fin du document.

AppWare : Vous êtes autorisé à (a) effectuer et utiliser des copies du
Logiciel conformément au nombre spécifié sur le justificatif d'achat,
(b) utiliser les Fichiers Exemple à des fins de développement, de
copie et de distribution d'applications AppWare, à la seule condition
que ces dernières constituent un perfectionnement substantiel des
Fichiers Exemple et (c) diffuser les ALM nécessaires à ces
applications AppWare uniquement en relation avec les applications,
sous réserve (i) que vous n'utilisiez pas les logos, noms ou marques
de Novell ou du propriétaire des ALM, (ii) que vous incluiez une
notice relative aux droits d'auteur sur le support contenant les
applications, (iii) que vous acceptiez d'indemniser Novell et ses
bailleurs de licences contre toutes poursuites judiciaires ou procès
pouvant découler de l'utilisation ou de la diffusion des applications et
(iv) qu'aucune des applications diffusées ne concurrence de manière
substantielle AppWare. Vous n'êtes pas autorisé à copier ou diffuser
tout autre type de fichier, y compris les Fichiers Exemple, les
Fichiers d'Aide, les Fichiers d'En-tête, les Fichiers de Projet, les
Fichiers de Configuration, les Fichiers Divers ou autres Outils de
Développement (comme défini dans la Documentation AppWare).
Vous n'êtes pas autorisé à copier ou diffuser tout ou partie de la
Documentation AppWare.

Envoy : Conformément aux dispositions de la licence Envoy, vous
êtes autorisé à effectuer et utiliser le nombre de copies du logiciel
Envoy Driver spécifié sur votre justificatif d'achat. Novell vous
concède également le droit de diffuser librement le logiciel Envoy
Viewer (« Runtime Viewer ou Distributable Viewer ») sous la forme
d'un fichier Envoy développé à l'aide de Envoy Driver, sous réserve
(a) que vous n'utilisiez pas les logos, noms ou marques de Novell,
(b) que vous incluiez une notice relative aux droits d'auteur sur le
support contenant le Viewer et (c) que vous vous engagiez à
indemniser Novell et ses bailleurs de licences contre toutes
poursuites judiciaires ou procès pouvant découler de l'utilisation ou
de la diffusion du logiciel Viewer dans le cadre de la diffusion d'un
fichier Envoy. « Envoy Driver » désigne le Pilote vous permettant de
créer des fichiers Envoy à partir d 'autres applications. « Envoy
Distributable Viewer » désigne la visionneuse qui vous permet de
visualiser et manipuler le fichier Envoy et « Envoy Runtime
Viewer » fait référence à la visionneuse qui, jointe à un fichier
Envoy, vous permet de visualiser ce dernier. Vous êtes responsable,
envers les utilisateurs finaux, de tout support technique de base
inhérent à tout logiciel Viewer diffusé.

Logiciel GroupWise Client : Vous êtes autorisé à utiliser le Logiciel
selon le nombre de copies, et la ou les plates-formes stipulés sur le
justificatif d'achat. Sur des ordinateurs ou des stations de travail
connectés à un réseau, le nombre de copies du Logiciel réputées
« utilisées » correspond au nombre de boîtes aux lettres utilisateur
que vous possédez ou envisagez de posséder sur votre réseau. Sur les
ordinateurs ou stations de travail connectés à un système de
messagerie publique, le nombre de copies du Logiciel réputées
« utilisées » correspond (i) au nombre maximum d'ordinateurs sur
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lesquels le Logiciel est Chargé en mémoire vive ou en mémoire
virtuelle, ou (ii) au nombre maximum d'ordinateurs sur lesquels le
Logiciel est Stocké simultanément, par exemple, sur disque dur ou
sur toute autre forme de support. La licence du Logicial client de
GroupWise vous autorise également à accéder à SoftSolutions par le
biais d'un serveur de documents à distance SoftSolutions.

Logiciel Serveur de Messages GroupWise : Le Logiciel Serveur de
Messages que vous exécutez sur un ordinateur, une station de travail
ou un serveur de fichiers faisant office de serveur de messages ne
requiert qu'une seule licence desservant autant d'ordinateurs que
nécessaire au sein d'un même domaine. Un « domaine » est un
regroupement logique de plusieurs bureaux de poste et/ou de
passerelles gérés par un seul serveur de messages.

Logiciel de Passerelle GroupWise : Le Logiciel de Passerelle est
réputé « utilisé » lorsqu'il est partiellement ou intégralement Chargé
en mémoire vive ou en mémoire virtuelle, ou bien Stocké sur un
disque dur ou sur toute autre forme de support.

SoftSolutions : Vous êtes autorisé à installer le Logiciel sur un
ordinateur monoposte, un seul terminal ou une seule station de travail
d'un réseau local/étendu ou composé d'ordinateurs à usage collectif.
Vous devez posséder une licence pour chaque copie du Logiciel,
qu'elle soit exécutée à partir d'un ordinateur hôte, de la mémoire ou
d'un ordinateur portable, ou qu'elle y réside ; ou encore qu'elle soit
stockée sur toute forme de support, sur un ou plusieurs ordinateurs multi-
ou mono-utilisateur, ou sur des réseaux locaux/étendus (serveurs et

stations de travail/clients). Par ailleurs, vous devez posséder une
licence pour chaque ordinateur qui accède au Logiciel par le biais
d'un serveur de documents à distance SoftSolutions. Vous n'êtes
autorisé à utiliser le Logiciel que dans un seul environnement
(Windows ou DOS) à la fois. Une licence Server Enhancement
Module (SEM) est requise pour chaque licence de Serveur de
Fichiers, bien qu'une copie de la licence SEM doive être chargée
pour chaque Ensemble de données et qu'un groupe de fichiers
programme SoftSolutions puisse accéder à plusieurs Ensembles de
données.

Autres logiciels d'application Novell : Vous êtes autorisé à utiliser
le Logiciel conformément au nombre de copies, et à la ou les plates-
formes stipulés dans votre justificatif d'achat. Sur un ordinateur
mono-utilisateur ou sur une station de travail non connecté à un
réseau, le Logiciel est réputé « utilisé » lorsqu'il est Chargé ou
Stocké en totalité ou en partie. Sur des ordinateurs mono-utilisateur
ou sur des stations de travail connectés à un réseau, le nombre de
copies du Logiciel réputées « utilisées » correspond (i) au nombre
maximum d'ordinateurs sur lesquels le Logiciel est Chargé
simultanément ou (ii) au nombre maximum d'ordinateurs sur
lesquels le Logiciel est Stocké. Sur un ordinateur multi-utilisateur, le
nombre de copies du Logiciel réputées « utilisées » correspond au
nombre maximum de sessions exécutées simultanément.

Généralités
Documentation, et utilisation sur ordinateurs personnels et
portables : Vous êtes autorisé à effectuer des copies de la
Documentation pour assister l'utilisation légale du Logiciel. Novell
vous concède le droit d'utiliser une copie du Logiciel sur un
ordinateur personnel ou portable, à la condition que cette copie ne
soit en aucun cas Chargée lorsque le Logiciel est Chargé sur votre
ordinateur principal. Cette disposition relative à l'utilisation de
l'ordinateur personnel ou portable ne s'applique pas si vous avez
acquis une licence pour le Logiciel dans le cadre d'un programme
réservé aux établissements scolaires et aux organisations caritatives.

Restrictions. Vous ne pouvez en aucun cas louer, prêter, décompiler
ou désassembler le Logiciel, ni en créer des oeuvres dérivées. Quel
que soit le nombre de supports inclus avec le Logiciel, vous n'êtes
pas autorisé à utiliser le Logiciel en dehors des cas expressément
prévus dans le présent contrat et dans votre justificatif d'achat.

L'acquisition de la licence peut être réglementée par des conditions
spéciales, imprimées sur l'emballage contenant le Logiciel et
mentionnées dans le présent Contrat. Par ailleurs, si les termes et
conditions du présent Contrat ne sont pas respectés, ce dernier est
automatiquement annulé et vous vous engagez à détruire toutes les
copies du Logiciel et de la Documentation. Novell vous accorde le
droit de les céder définitivement, à la seule condition que toutes les
copies, y compris les versions antérieures et celles mises à jour,
soient cédées en une seule fois et que l'acquéreur accepte les termes
du présent Contrat.

Si vous avez des questions à propos du présent Contrat, ou à propos
des conditions spéciales accordées aux établissements scolaires et
aux organisations caritatives, veuillez contacter Novell Sales Center,
1555 N. Technology Way, Orem, UT 84057-2399, ou consulter votre
revendeur agréé local.
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For Products Purchased in All Other Countries (English)

(Standard Retail and OEM Limited Warranty and License Agreement for Novell Applications Products)

Limited Warranty
This Software is licensed AS IS. If for any reason you are
dissatisfied with the Software, return it with the package and proof of
purchase to your reseller within 90 days of the date of purchase for a
full refund. This refund is not available if you received the Software
as part of a Novell/Original Equipment Manufacturer bundle. If any
materials or media in this package are defective, return them to
Novell within 90 days of the date of purchase and they will be
replaced at no charge.

THE SOFTWARE IS NOT WARRANTED FOR USE ON
SYSTEMS WITH WHICH IT IS NOT COMPATIBLE. NOVELL
MAKES NO WARRANTY OR REPRESENTATION NOT SET
FORTH IN THIS LIMITED WARRANTY. NOVELL DISCLAIMS
ALL IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. NOVELL DOES
NOT WARRANT THAT THE SOFTWARE AND
DOCUMENTATION ARE WITHOUT DEFECT. NOVELL'S
LIABILITY ARISING FROM YOUR USE OF THE SOFTWARE,
DOCUMENTATION, OR RELATED SERVICES IS LIMITED TO
YOUR PURCHASE PRICE. NEITHER NOVELL NOR ANY OF
ITS LICENSORS SHALL BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE
DAMAGES. NEITHER NOVELL NOR ANY OF ITS LICENSORS
IS RESPONSIBLE FOR LOST PROFITS OR DATA OR FOR
BUSINESS INTERRUPTION.

Some jurisdictions do not allow limiting implied warranties or
liability for incidental or consequential damages, and some have
consumer protection laws which may supersede these limitations. As
a result, these limitations may not apply to you.

Novell Software License Agreement
The Novell software program(s) and documentation ("Software" and
"Documentation") for which you have purchased a license are
protected by copyright laws and international treaties and your use of
them is subject to the terms of this License. Novell software
programs are used in various ways and require different license
rights. The type of license that applies depends on the program for
which you purchased a license as shown on your Proof of Purchase
and the definitions and grants of license below. If the Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both at the same time. This License supersedes any prior version
license. This License is granted by Novell Ireland Software Ltd. for
products purchased in Europe, the Middle East and Africa, and by
Novell, Inc. for products purchased elsewhere. Each is referred to in
this License as “Novell”.

You may use the Software listed on the Proof of Purchase you have
received or will receive subject to and only in the manner described
in this License. If you purchased a license for multiple programs,
such as in PerfectOffice Standard, PerfectOffice Professional, or in
PerfectOffice Select, you have a single license covering those
programs and you may not separate them among multiple users. You
may make an archival copy of the Software for each license.

For AppWare: You may (a) make and use up to the number of
copies indicated on your Proof of Purchase, (b) use Sample Files to
develop, copy and distribute AppWare applications, provided they
are substantially more robust and have substantially greater
functionality than the Sample Files, and (c) distribute ALMs that are
necessary for those AppWare applications solely in conjunction with
the applications, provided (i) you do not use the logo, name or
trademarks of Novell or the owner of the ALMs, (ii) include a valid
copyright notice on media containing the applications, (iii) you agree

to indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the applications, and (iv)
none of the applications you distribute substantially competes with
the AppWare. You may not copy or distribute any other files,
including Sample Files, Help Files, Header Files, Project Files,
Configuration Files, Miscellaneous Files or Other Development
Tools (all as defined in the AppWare Documentation). You may not
copy and distribute any of the AppWare Documentation.

For Envoy: With the purchase of a license for Envoy, you may
make and use up to the number of copies of the Envoy Driver
indicated on your Proof of Purchase. You may also freely distribute
the Envoy Viewer (“Runtime Viewer or Distributable Viewer”) with
an Envoy file developed using the Envoy Driver, provided you (a) do
not use the logo, name or trademarks of Novell, (b) include a valid
copyright notice on media containing the Viewer, and (c) agree to
indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the Viewer as part of the
Envoy file you distribute. "Envoy Driver" means the Driver that
enables you to create Envoy files from within other applications.
"Envoy Distributable Viewer" means the viewer that allows you to
view and manipulate the Envoy file. "Envoy Runtime Viewer"
means the viewer that, when bound to an Envoy file, enables you to
view the Envoy file. You are responsible for all primary technical
support to the end-user of any Viewer you distribute.

For GroupWise Client Software: You may use the Software in the
quantity and on the platform(s) listed on the Proof of Purchase. For
computers or workstations attached to a network, the quantity of
Software "in use" is the number of user mailboxes that you have or
intend to have on your network. For computers or workstations
attached to a public messaging system, the quantity of the Software
"in use" is considered to be the greater of (i) the maximum number of
computers on which the Software is loaded in memory or virtual
memory (“Loaded”), or (ii) the maximum number of computers on
which the Software is stored, for example, on a hard disk or other
storage device (“Stored”) at any one time. In addition, a GroupWise
Client license includes the right to access SoftSolutions via a
SoftWolutions Remote Document Server.

For GroupWise Message Server Software: Message Server
Software which you run on a computer, workstation, or file server
used as a message server requires a single license for as many
computers as necessary within a single domain. A "domain" is a
logical grouping of post offices and/or gateways serviced by a single
message server.

For GroupWise Gateway Software: Gateway Software is
considered "in use" when any portion of it is either loaded in memory
or virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

For SoftSolutions: You may install the Software on a single-user
computer or on a single terminal or workstation of a multi-user
computer or local/wide area network. Each copy of the Software
must be separately licensed whether executing from or residing on a
host computer, memory, or a Portable Mode Enabled computer; or
stored on a storage device of any kind, on multi-user computer(s),
single-user computer(s), or local/wide area networks (servers and
workstations/clients). In addition, a license is required for each
computer that accesses the Software via a SoftSolutions Remote
Document Server. You may use the Software in only a single
environment (Windows or DOS) at a time. A Server Enhancement
Module (SEM) license is required for each File Server license,
notwithstanding that a copy of the SEM needs to be loaded for each
Dataset and a single set of SoftSolutions program files may access
multiple Datasets.
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For Any Other Novell Applications Software Products: You may
use the Software in the quantity and on the platform(s) listed on the
Proof of Purchase. For a single-user computer or workstation not
attached to a network, the Software is considered "in use" when any
portion of it is either Loaded or Stored. For single-user computers or
workstations attached to a network, the quantity of the Software "in
use" is the greater of (i) the maximum number of computers on
which the Software is Loaded at any one time, or (ii) the maximum
number of computers on which the Software is Stored. On a multi-
user computer, the quantity of Software "in use" is the maximum
number of sessions executed at any one time.

General
Documentation, Home and Portable Use: You may make copies of
the Documentation to support your authorized use of the Software.
You may use a copy of the Software on a home or portable computer
if that copy is never Loaded at the same time it is Loaded on your
primary computer. This home or portable use provision does not
apply if you licensed this Software under an education or charitable
institution pricing program.

Restrictions. You may not rent, lease, decompile, disassemble,
reverse engineer, or create derivative works of the Software.
Irrespective of the number of sets of media included with the
Software, you may use the Software only as provided in this License
and the Proof of Purchase. Certain qualifications may apply to the
purchase of this License. When present, they are printed on the
Software package and form part of this License. If you breach any of
the terms of this License, it automatically terminates and you must
destroy all copies of the Software and Documentation. You may
permanently transfer the Software and Documentation only if all
copies, including prior and updated versions, are transferred together
and the transferee agrees to the terms of this License.

If you have any questions about this License or special programs for
education or charitable organizations, please contact the Novell Sales
Center, 1555 N. Technology Way, Orem, UT 84057-2399 or contact
your local Novell office or authorized Reseller.
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For Products Purchased in Austrialia and New Zealand (English)

(Standard Retail and OEM Limited Warranty and License Agreement for Novell Applications Products)

Limited Warranty
A.This Part A is subject to provisions of Part B which follows below.
This Software is licensed AS IS. If for any reason you are
dissatisfied with the Software, return it with the package and proof of
purchase to your reseller within 90 days of the date of purchase for a
full refund. This refund is not available if you received the Software
as part of a Novell/Original Equipment Manufacturer bundle. If any
materials or media in this package are defective, return them to
Novell within 90 days of the date of purchase and they will be
replaced at no charge.

THE SOFTWARE IS NOT WARRANTED FOR USE ON
SYSTEMS WITH WHICH IT IS NOT COMPATIBLE. NOVELL
MAKES NO WARRANTY OR REPRESENTATION NOT SET
FORTH IN THIS LIMITED WARRANTY. NOVELL DISCLAIMS
ALL IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. NOVELL DOES
NOT WARRANT THAT THE SOFTWARE AND
DOCUMENTATION ARE WITHOUT DEFECT. NOVELL'S
LIABILITY ARISING FROM YOUR USE OF THE SOFTWARE,
DOCUMENTATION, OR RELATED SERVICES IS LIMITED TO
YOUR PURCHASE PRICE. NEITHER NOVELL NOR ANY OF
ITS LICENSORS SHALL BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE
DAMAGES. NEITHER NOVELL NOR ANY OF ITS LICENSORS
IS RESPONSIBLE FOR LOST PROFITS OR DATA OR FOR
BUSINESS INTERRUPTION.

B.Trade Practices Act. Where any legislation, such as the Trade
Practices Act 1974, implies into this Agreement any condition or
warranty and that legislation avoids or prohibits provisions in a
contract excluding the application of the condition or warranty, the
liability of Novell for any breach of the condition or warranty is
limited at the option of Novell to any one or more of the following:
a) if the breach relates to goods, replacing the goods or the payment
of the cost of acquiring equivalent goods or repairing the goods or
payment of the cost of repairing the goods; b) if the breach relates to
services, the supplying of the services again or the payment of the
cost of having the services supplied again. Nothing herein is
intended to restrict or exclude any liability of Novell under Part VA
of the Trade Practices Act 1974.

Novell Software License Agreement
The Novell software program(s) and documentation ("Software" and
"Documentation") for which you have purchased a license are
protected by copyright laws and international treaties and your use of
them is subject to the terms of this License. Novell software
programs are used in various ways and require different license
rights. The type of license that applies depends on the program for
which you purchased a license as shown on your Proof of Purchase
and the definitions and grants of license below. If the Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both at the same time. This License supersedes any prior version
license. This License is granted by Novell Ireland Software Ltd. for
products purchased in Europe, the Middle East and Africa, and by
Novell, Inc. for products purchased elsewhere. Each is referred to in
this License as “Novell”.

You may use the Software listed on the Proof of Purchase you have
received or will receive subject to and only in the manner described
in this License. If you purchased a license for multiple programs,
such as in PerfectOffice Standard, PerfectOffice Professional, or in
PerfectOffice Select, you have a single license covering those

programs and you may not separate them among multiple users. You
may make an archival copy of the Software for each license.

For AppWare: You may (a) make and use up to the number of
copies indicated on your Proof of Purchase, (b) use Sample Files to
develop, copy and distribute AppWare applications, provided they
are substantially more robust and have substantially greater
functionality than the Sample Files, and (c) distribute ALMs that are
necessary for those AppWare applications solely in conjunction with
the applications, provided (i) you do not use the logo, name or
trademarks of Novell or the owner of the ALMs, (ii) include a valid
copyright notice on media containing the applications, (iii) you agree
to indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the applications, and (iv)
none of the applications you distribute substantially competes with
the AppWare. You may not copy or distribute any other files,
including Sample Files, Help Files, Header Files, Project Files,
Configuration Files, Miscellaneous Files or Other Development
Tools (all as defined in the AppWare Documentation). You may not
copy and distribute any of the AppWare Documentation.

For Envoy: With the purchase of a license for Envoy, you may
make and use up to the number of copies of the Envoy Driver
indicated on your Proof of Purchase. You may also freely distribute
the Envoy Viewer (“Runtime Viewer or Distributable Viewer”) with
an Envoy file developed using the Envoy Driver, provided you (a) do
not use the logo, name or trademarks of Novell, (b) include a valid
copyright notice on media containing the Viewer, and (c) agree to
indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the Viewer as part of the
Envoy file you distribute. "Envoy Driver" means the Driver that
enables you to create Envoy files from within other applications.
"Envoy Distributable Viewer" means the viewer that allows you to
view and manipulate the Envoy file. "Envoy Runtime Viewer"
means the viewer that, when bound to an Envoy file, enables you to
view the Envoy file. You are responsible for all primary technical
support to the end-user of any Viewer you distribute.

For GroupWise Client Software: You may use the Software in the
quantity and on the platform(s) listed on the Proof of Purchase. For
computers or workstations attached to a network, the quantity of
Software "in use" is the number of user mailboxes that you have or
intend to have on your network. For computers or workstations
attached to a public messaging system, the quantity of the Software
"in use" is considered to be the greater of (i) the maximum number of
computers on which the Software is loaded in memory or virtual
memory (“Loaded”), or (ii) the maximum number of computers on
which the Software is stored, for example, on a hard disk or other
storage device (“Stored”) at any one time. In addition, a GroupWise
Client license includes the right to access SoftSolutions via a
SoftWolutions Remote Document Server.

For GroupWise Message Server Software: Message Server
Software which you run on a computer, workstation, or file server
used as a message server requires a single license for as many
computers as necessary within a single domain. A "domain" is a
logical grouping of post offices and/or gateways serviced by a single
message server.

For GroupWise Gateway Software: Gateway Software is
considered "in use" when any portion of it is either loaded in memory
or virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

For SoftSolutions: You may install the Software on a single-user
computer or on a single terminal or workstation of a multi-user
computer or local/wide area network. Each copy of the Software
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must be separately licensed whether executing from or residing on a
host computer, memory, or a Portable Mode Enabled computer; or
stored on a storage device of any kind, on multi-user computer(s),
single-user computer(s), or local/wide area networks (servers and
workstations/clients). In addition, a license is required for each
computer that accesses the Software via a SoftSolutions Remote
Document Server. You may use the Software in only a single
environment (Windows or DOS) at a time. A Server Enhancement
Module (SEM) license is required for each File Server license,
notwithstanding that a copy of the SEM needs to be loaded for each
Dataset and a single set of SoftSolutions program files may access
multiple Datasets.

For Any Other Novell Applications Software Products: You may
use the Software in the quantity and on the platform(s) listed on the
Proof of Purchase. For a single-user computer or workstation not
attached to a network, the Software is considered "in use" when any
portion of it is either Loaded or Stored. For single-user computers or
workstations attached to a network, the quantity of the Software "in
use" is the greater of (i) the maximum number of computers on
which the Software is Loaded at any one time, or (ii) the maximum
number of computers on which the Software is Stored. On a multi-
user computer, the quantity of Software "in use" is the maximum
number of sessions executed at any one time.

General
Documentation, Home and Portable Use: You may make copies of
the Documentation to support your authorized use of the Software.
You may use a copy of the Software on a home or portable computer
if that copy is never Loaded at the same time it is Loaded on your
primary computer. This home or portable use provision does not
apply if you licensed this Software under an education or charitable
institution pricing program.

Restrictions. You may not rent, lease, decompile, disassemble,
reverse engineer, or create derivative works of the Software.
Irrespective of the number of sets of media included with the
Software, you may use the Software only as provided in this License
and the Proof of Purchase. Certain qualifications may apply to the
purchase of this License. When present, they are printed on the
Software package and form part of this License. If you breach any of
the terms of this License, it automatically terminates and you must
destroy all copies of the Software and Documentation. You may
permanently transfer the Software and Documentation only if all
copies, including prior and updated versions, are transferred together
and the transferee agrees to the terms of this License.

If you have any questions about this License or special programs for
education or charitable organizations, please contact the Novell Sales
Center, 1555 N. Technology Way, Orem, UT 84057-2399 or contact
your local Novell office or authorised Reseller.
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For Products Purchased in United Kingdom (English)

(Standard Retail and OEM Limited Warranty and License Agreement for Novell Applications Products)

Limited Warranty
If you enter into this Agreement as part of a consumer transaction: if
any materials or media in this package are defective, return them
within 90 days of the original date of purchase, and Novell will
replace them at no charge. This refund is not available if the
Software is purchased as part of a Novell/Original Equipment
Manufacturer bundle. THE FOREGOING DOES NOT AND WILL
NOT AFFECT YOUR STATUTORY RIGHTS AS A CONSUMER.

If you do not enter into this Agreement as part of a consumer
transaction: THIS SOFTWARE IS LICENCED AS IS. The right to
use the Software is granted without any further warranty, condition,
representation, or other term express or implied relating to the
performance, quality, or fitness for use of the Software or written
materials accompanying the Software. Novell shall not be liable for
any loss or damage of any kind (other than personal injury or death)
arising from use of the Software or accompanying written materials
or from errors, deficiencies, or faults therein, whether such loss or
damage is caused by negligence or otherwise.

Novell Software License Agreement
The Novell software program(s) and documentation ("Software" and
"Documentation") for which you have purchased a license are
protected by copyright laws and international treaties and your use of
them is subject to the terms of this License. Novell software
programs are used in various ways and require different license
rights. The type of license that applies depends on the program for
which you purchased a license as shown on your Proof of Purchase
and the definitions and grants of license below. If the Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both at the same time. This License supersedes any prior version
license. This License is granted by Novell Ireland Software Ltd. for
products purchased in Europe, the Middle East and Africa, and by
Novell, Inc. for products purchased elsewhere. Each is referred to in
this License as “Novell”.

You may use the Software listed on the Proof of Purchase you have
received or will receive subject to and only in the manner described
in this License. If you purchased a license for multiple programs,
such as in PerfectOffice Standard, PerfectOffice Professional, or in
PerfectOffice Select, you have a single license covering those
programs and you may not separate them among multiple users. You
may make an archival copy of the Software for each license.

For AppWare: You may (a) make and use up to the number of
copies indicated on your Proof of Purchase, (b) use Sample Files to
develop, copy and distribute AppWare applications, provided they
are substantially more robust and have substantially greater
functionality than the Sample Files, and (c) distribute ALMs that are
necessary for those AppWare applications solely in conjunction with
the applications, provided (i) you do not use the logo, name or
trademarks of Novell or the owner of the ALMs, (ii) include a valid
copyright notice on media containing the applications, (iii) you agree
to indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the applications, and (iv)
none of the applications you distribute substantially competes with
the AppWare. You may not copy or distribute any other files,
including Sample Files, Help Files, Header Files, Project Files,
Configuration Files, Miscellaneous Files or Other Development
Tools (all as defined in the AppWare Documentation). You may not
copy and distribute any of the AppWare Documentation.

For Envoy: With the purchase of a license for Envoy, you may
make and use up to the number of copies of the Envoy Driver

indicated on your Proof of Purchase. You may also freely distribute
the Envoy Viewer (“Runtime Viewer or Distributable Viewer”) with
an Envoy file developed using the Envoy Driver, provided you (a) do
not use the logo, name or trademarks of Novell, (b) include a valid
copyright notice on media containing the Viewer, and (c) agree to
indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the Viewer as part of the
Envoy file you distribute. "Envoy Driver" means the Driver that
enables you to create Envoy files from within other applications.
"Envoy Distributable Viewer" means the viewer that allows you to
view and manipulate the Envoy file. "Envoy Runtime Viewer"
means the viewer that, when bound to an Envoy file, enables you to
view the Envoy file. You are responsible for all primary technical
support to the end-user of any Viewer you distribute.

For GroupWise Client Software: You may use the Software in the
quantity and on the platform(s) listed on the Proof of Purchase. For
computers or workstations attached to a network, the quantity of
Software "in use" is the number of user mailboxes that you have or
intend to have on your network. For computers or workstations
attached to a public messaging system, the quantity of the Software
"in use" is considered to be the greater of (i) the maximum number of
computers on which the Software is loaded in memory or virtual
memory (“Loaded”), or (ii) the maximum number of computers on
which the Software is stored, for example, on a hard disk or other
storage device (“Stored”) at any one time. In addition, a GroupWise
Client license includes the right to access SoftSolutions via a
SoftWolutions Remote Document Server.

For GroupWise Message Server Software: Message Server
Software which you run on a computer, workstation, or file server
used as a message server requires a single license for as many
computers as necessary within a single domain. A "domain" is a
logical grouping of post offices and/or gateways serviced by a single
message server.

For GroupWise Gateway Software: Gateway Software is
considered "in use" when any portion of it is either loaded in memory
or virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

For SoftSolutions: You may install the Software on a single-user
computer or on a single terminal or workstation of a multi-user
computer or local/wide area network. Each copy of the Software
must be separately licensed whether executing from or residing on a
host computer, memory, or a Portable Mode Enabled computer; or
stored on a storage device of any kind, on multi-user computer(s),
single-user computer(s), or local/wide area networks (servers and
workstations/clients). In addition, a license is required for each
computer that accesses the Software via a SoftSolutions Remote
Document Server. You may use the Software in only a single
environment (Windows or DOS) at a time. A Server Enhancement
Module (SEM) license is required for each File Server license,
notwithstanding that a copy of the SEM needs to be loaded for each
Dataset and a single set of SoftSolutions program files may access
multiple Datasets.

For Any Other Novell Applications Software Products: You may
use the Software in the quantity and on the platform(s) listed on the
Proof of Purchase. For a single-user computer or workstation not
attached to a network, the Software is considered "in use" when any
portion of it is either Loaded or Stored. For single-user computers or
workstations attached to a network, the quantity of the Software "in
use" is the greater of (i) the maximum number of computers on
which the Software is Loaded at any one time, or (ii) the maximum
number of computers on which the Software is Stored. On a multi-
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user computer, the quantity of Software "in use" is the maximum
number of sessions executed at any one time.

General
Documentation, Home and Portable Use: You may make copies of
the Documentation to support your authorized use of the Software.
You may use a copy of the Software on a home or portable computer
if that copy is never Loaded at the same time it is Loaded on your
primary computer. This home or portable use provision does not
apply if you licensed this Software under an education or charitable
institution pricing program.

Restrictions. You may not rent, lease, decompile, disassemble,
reverse engineer, or create derivative works of the Software.
Irrespective of the number of sets of media included with the
Software, you may use the Software only as provided in this License
and the Proof of Purchase. Certain qualifications may apply to the
purchase of this License. When present, they are printed on the
Software package and form part of this License. If you breach any of
the terms of this License, it automatically terminates and you must
destroy all copies of the Software and Documentation. You may
permanently transfer the Software and Documentation only if all
copies, including prior and updated versions, are transferred together
and the transferee agrees to the terms of this License.

If you have any questions about this License or special programs for
education or charitable organizations, please contact the Novell Sales
Center, 1555 N. Technology Way, Orem, UT 84057-2399 or contact
your local Novell office or authorised Reseller.
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For Products Purchased in United States (English)

(Standard Retail and OEM Limited Warranty and License Agreement for Novell Applications Products)

Limited Warranty
This Software is licensed AS IS. If for any reason you are
dissatisfied with the Software, return it with the package and proof of
purchase to your reseller within 90 days of the date of purchase for a
full refund. This refund is not available if you received the Software
as part of a Novell/Original Equipment Manufacturer bundle. If any
materials or media in this package are defective, return them to
Novell within 90 days of the date of purchase and they will be
replaced at no charge.

THE SOFTWARE IS NOT WARRANTED FOR USE ON
SYSTEMS WITH WHICH IT IS NOT COMPATIBLE. NOVELL
MAKES NO WARRANTY OR REPRESENTATION NOT SET
FORTH IN THIS LIMITED WARRANTY. NOVELL DISCLAIMS
ALL IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. NOVELL DOES
NOT WARRANT THAT THE SOFTWARE AND
DOCUMENTATION ARE WITHOUT DEFECT. NOVELL'S
LIABILITY ARISING FROM YOUR USE OF THE SOFTWARE,
DOCUMENTATION, OR RELATED SERVICES IS LIMITED TO
YOUR PURCHASE PRICE. NEITHER NOVELL NOR ANY OF
ITS LICENSORS SHALL BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE
DAMAGES. NEITHER NOVELL NOR ANY OF ITS LICENSORS
IS RESPONSIBLE FOR LOST PROFITS OR DATA OR FOR
BUSINESS INTERRUPTION.

Some jurisdictions do not allow limiting implied warranties or
liability for incidental or consequential damages, and some have
consumer protection laws which may supersede these limitations. As
a result, these limitations may not apply to you.

Novell Software License Agreement
The Novell software program(s) and documentation ("Software" and
"Documentation") for which you have purchased a license are
protected by copyright laws and international treaties and your use of
them is subject to the terms of this License. Novell software
programs are used in various ways and require different license
rights. The type of license that applies depends on the program for
which you purchased a license as shown on your Proof of Purchase
and the definitions and grants of license below. If the Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both at the same time. This License supersedes any prior version
license. This License is granted by Novell Ireland Software Ltd. for
products purchased in Europe, the Middle East and Africa, and by
Novell, Inc. for products purchased elsewhere. Each is referred to in
this License as “Novell”.

You may use the Software listed on the Proof of Purchase you have
received or will receive subject to and only in the manner described
in this License. If you purchased a license for multiple programs,
such as in PerfectOffice Standard, PerfectOffice Professional, or in
PerfectOffice Select, you have a single license covering those
programs and you may not separate them among multiple users. You
may make an archival copy of the Software for each license.

For AppWare: You may (a) make and use up to the number of
copies indicated on your Proof of Purchase, (b) use Sample Files to
develop, copy and distribute AppWare applications, provided they
are substantially more robust and have substantially greater
functionality than the Sample Files, and (c) distribute ALMs that are
necessary for those AppWare applications solely in conjunction with
the applications, provided (i) you do not use the logo, name or
trademarks of Novell or the owner of the ALMs, (ii) include a valid
copyright notice on media containing the applications, (iii) you agree

to indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the applications, and (iv)
none of the applications you distribute substantially competes with
the AppWare. You may not copy or distribute any other files,
including Sample Files, Help Files, Header Files, Project Files,
Configuration Files, Miscellaneous Files or Other Development
Tools (all as defined in the AppWare Documentation). You may not
copy and distribute any of the AppWare Documentation.

For Envoy: With the purchase of a license for Envoy, you may
make and use up to the number of copies of the Envoy Driver
indicated on your Proof of Purchase. You may also freely distribute
the Envoy Viewer (“Runtime Viewer or Distributable Viewer”) with
an Envoy file developed using the Envoy Driver, provided you (a) do
not use the logo, name or trademarks of Novell, (b) include a valid
copyright notice on media containing the Viewer, and (c) agree to
indemnify Novell and its licensors against any claims or lawsuits
arising from your use or distribution of the Viewer as part of the
Envoy file you distribute. "Envoy Driver" means the Driver that
enables you to create Envoy files from within other applications.
"Envoy Distributable Viewer" means the viewer that allows you to
view and manipulate the Envoy file. "Envoy Runtime Viewer"
means the viewer that, when bound to an Envoy file, enables you to
view the Envoy file. You are responsible for all primary technical
support to the end-user of any Viewer you distribute.

For GroupWise Client Software: You may use the Software in the
quantity and on the platform(s) listed on the Proof of Purchase. For
computers or workstations attached to a network, the quantity of
Software "in use" is the number of user mailboxes that you have or
intend to have on your network. For computers or workstations
attached to a public messaging system, the quantity of the Software
"in use" is considered to be the greater of (i) the maximum number of
computers on which the Software is loaded in memory or virtual
memory (“Loaded”), or (ii) the maximum number of computers on
which the Software is stored, for example, on a hard disk or other
storage device (“Stored”) at any one time. In addition, a GroupWise
Client license includes the right to access SoftSolutions via a
SoftWolutions Remote Document Server.

For GroupWise Message Server Software: Message Server
Software which you run on a computer, workstation, or file server
used as a message server requires a single license for as many
computers as necessary within a single domain. A "domain" is a
logical grouping of post offices and/or gateways serviced by a single
message server.

For GroupWise Gateway Software: Gateway Software is
considered "in use" when any portion of it is either loaded in memory
or virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

For SoftSolutions: You may install the Software on a single-user
computer or on a single terminal or workstation of a multi-user
computer or local/wide area network. Each copy of the Software
must be separately licensed whether executing from or residing on a
host computer, memory, or a Portable Mode Enabled computer; or
stored on a storage device of any kind, on multi-user computer(s),
single-user computer(s), or local/wide area networks (servers and
workstations/clients). In addition, a license is required for each
computer that accesses the Software via a SoftSolutions Remote
Document Server. You may use the Software in only a single
environment (Windows or DOS) at a time. A Server Enhancement
Module (SEM) license is required for each File Server license,
notwithstanding that a copy of the SEM needs to be loaded for each
Dataset and a single set of SoftSolutions program files may access
multiple Datasets.
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For Any Other Novell Applications Software Products: You may
use the Software in the quantity and on the platform(s) listed on the
Proof of Purchase. For a single-user computer or workstation not
attached to a network, the Software is considered "in use" when any
portion of it is either Loaded or Stored. For single-user computers or
workstations attached to a network, the quantity of the Software "in
use" is the greater of (i) the maximum number of computers on
which the Software is Loaded at any one time, or (ii) the maximum
number of computers on which the Software is Stored. On a multi-
user computer, the quantity of Software "in use" is the maximum
number of sessions executed at any one time.

General
Documentation, Home and Portable Use: You may make copies of
the Documentation to support your authorized use of the Software.
You may use a copy of the Software on a home or portable computer
if that copy is never Loaded at the same time it is Loaded on your
primary computer. This home or portable use provision does not
apply if you licensed this Software under an education or charitable
institution pricing program.

Restrictions. You may not rent, lease, decompile, disassemble,
reverse engineer, or create derivative works of the Software.
Irrespective of the number of sets of media included with the
Software, you may use the Software only as provided in this License
and the Proof of Purchase. Certain qualifications may apply to the
purchase of this License. When present, they are printed on the
Software package and form part of this License. If you breach any of
the terms of this License, it automatically terminates and you must
destroy all copies of the Software and Documentation. You may
permanently transfer the Software and Documentation only if all
copies, including prior and updated versions, are transferred together
and the transferee agrees to the terms of this License.

US Government Restricted Rights. The Software and any
accompanying materials are provided with Restricted Rights. Use,
duplication, or disclosure by the Government is subject to restrictions
as set forth in subparagraph (c) (1) (ii) of The Rights in Technical
Data and Computer Software clause at DFARS 252.227-7013 or
subparagraphs (c) (1) and (2) of the Commercial Computer
Software—Restricted Rights at 48 CFR 52.227-19, as applicable.
Contractor/manufacturer is Novell, Inc. at the address below.

If you have any questions about this License or special programs for
education or charitable organizations, please contact the Novell
Sales Center, 1555 N. Technology Way, Orem, UT 84057-2399.
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Welcome

Welcome to Internet Publisher. This easy-to-use software tool for WordPerfect 6.1 for
Windows allows you to create HyperText Markup Language (HTML) documents for
publishing on the World Wide Web (WWW). You can also use the included Netscape
Navigator browser for viewing pages (or documents) on the WWW.

The Internet Publisher also comes with an integrated Envoy document viewer. This viewer
allows you to read any Envoy document on the WWW in its native format (.EVY).

IMPORTANT: To use the Netscape Navigator browser, at a minimum your computer must
have LAN WorkPlace 4.2 or some other TCP/IP stack and a WINSOCK.DLL installed and
functioning properly on your computer. Please see Recommended Internet Requirements
in the README.TXT file.

Creating a New HTML Document: The Basics

Nearly every page you read on the WWW has at least four basic HTML components:
headings, paragraphs, lists, and an address at the end that contains the author’s name or
company name and their Internet address.

This section shows you how to create your own HTML document using Internet Publisher
and these four basic components. Once you are comfortable with the basics, you can
further increase the versatility of your document by using some of the more advanced
HTML features found under Advanced Internet Publisher Tasks and Creating Hyperlinks.

A collection of sample HTML documents is located in the \WPIP\SAMPLES directory.
These files illustrate some of the capabilities of Internet Publisher. They can be modified
and used as examples for creating your own HTML documents, or they can be exported
so you can see how the various styles used in the documents appear in Netscape. You
can view or use any of the files with .WPD extensions by opening them in WordPerfect.

Selecting the
Internet Publisher
Template

When you begin a new HTML document in WordPerfect, you must first select the Internet
Publisher template. This template, like many of the templates already included with
WordPerfect, includes a predefined Toolbar which contains the options you will be using to
create your document (you can also use the HTML menu on the menu bar to select the
same options that are found on the Toolbar). For more information about templates, see
New in the WordPerfect 6.1 for Windows User’s Guide.

To select the Internet Publisher template,

1 In WordPerfect 6.1 for Windows, choose New from the File menu.

2 Highlight HTML Document in the Select Template text box, then choose Select.
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The default Internet Publisher Toolbar is displayed along with the HTML menu to the left of
Help on the menu bar. Any option found on the Toolbar or the HTML menu can be used to
create your HTML document.

Internet Publisher Toolbar HTML menu

3 In the Document Title text box, type a short, descriptive name, then choose OK.

This name will appear as the main heading of your HTML document, and will also appear
in the title bar of the browser when you export to HTML. To change the name, see
Changing a Document Title below. To change the name so that it appears in the title bar
area of the browser only, see Separating the Title from the Document Heading later in this
section.

Where do you go now? You can add headings, paragraphs, lists, or an address to your
document by completing any of the remaining tasks below.

Changing a Document Title
You can change the title that appears in your document and the title bar area of the
browser.

1 Triple-click anywhere on the title to select the entire title text.

or

Place the insertion point in the title where you want to insert new text.

or

Select the text you want to change.

2 Type the text you want.

You can also use these same steps to change any heading level in your document.

Separating the Title from the Document Heading
When you start a new HTML document, you are prompted for a document title. This title
appears as a heading at the beginning of your document, and also appears in the title bar
area of a browser. There may be times, however, when you want a graphics image to
serve as your document heading, not a title composed of text. In such cases, you can use
the “title only” style. This style allows you to convert the existing title of your document so
that it appears in the title bar area of the browser only.

1 Place the insertion point anywhere within the existing title.

2 Click on the Toolbar.

3 Select Title Only (TITLE), then choose OK.

The title will appear dimmed, indicating that the “title only” style is in effect.

Creating a New HTML Document: The Basics 17



Creating a
Document Heading

Headings in an HTML document assist a reader in quickly finding the information they
want. You can choose from six different styles of levels or headings. These headings are
defined as H1 through H6. The H1 style is usually reserved for the document title which
you used when you started this new HTML document. The H2 style is used for major
sections in your document and the H3 style is used for minor sections. Each subsequent
style, H4 through H6, functions as a sub-level heading to the previous level.

To create a document heading,

1 On a new line in your document, click on the Toolbar. (You may need to press
Enter to insert a hard return and start a new line.)

2 Select the heading type you want, then choose OK.

Heading Type Style Name Tag

Document Title doc title <TITLE> and <H1>
Document Heading doc head <H1>
Major Heading major head <H2>
Minor Heading minor head <H3>
Sub Heading sub head <H4>
Sub Sub Heading sub sub head <H5>
Sub Sub Sub Heading sub sub sub <H6>
Title Only title only <TITLE>

3 Type the text of the heading, then press Enter to end the style and insert a hard return.
(The hard return will appear as a double-space in your working document and your
exported HTML document.)

HINT: You can also select existing text, then choose the heading type you want applied to
it.

If you would like to preview your document in the Netscape Navigator browser at this point,
see The Mechanics of an HTML Document later in this document.

Creating
Paragraphs

1 On a new line in your document, type your text as you normally would (you may need
to press Enter to insert a hard return and start a new line).

2 When you are finished typing the paragraph, press Enter to insert a hard return and
begin a new paragraph.

IMPORTANT: If you have manually-inserted indents or tabs in your working document,
they will not be exported to HTML or seen in your reader’s browser. If you would like to
use indents or tabs that are visible in Netscape and other browsers, you should use the
Preformatted Text paragraph type. For more information about using this and other
paragraph types, see Adding Paragraph Types in Advanced Internet Publisher Tasks.
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If you would like to preview your document in the Netscape Navigator browser at this point,
see The Mechanics of an HTML Document later in this document.

Creating a List There are five varieties of lists you can create: bullet (unordered), numbered (ordered),
descriptive, menu, and directory lists.

You can use bullet lists to identify items that are not in any particular order of importance
and numbered lists to identify a sequence of steps.

Descriptive lists are typically used for glossary or bibliography entries. Instead of bullets or
numbers to mark the entries, a descriptive list is marked with indents. For example, a
glossary entry would include a word title on one line and a hanging indented paragraph
(the actual description) on the next line.

Menu lists and directory lists are similar to descriptive lists, but they use bullets instead of
indents to mark entries. A menu list, directory list, and bullet list differ in name only. Either
can be used if all you want is an unordered list of items.

To create a list,

1 On a new line in your document, click on the Toolbar.

2 Select the list type you want, then choose OK.

3 Type the text for the first-level item.

4 To insert another first-level item, press Enter, then type text.

You can change the level of a current item by pressing Tab to move down a level, or by
pressing Shift+Tab to move up a level.

5 When you are finished, insert a hard return, then click on the Toolbar to end the
list.

If you would like to preview your document in the Netscape Navigator browser as this
point, see The Mechanics of an HTML Document later in this document.

Creating a
Document Address

An address at the end of your document is an important part of any HTML document. It
serves as a statement of authorship and also provides a reader with the information
necessary to send you questions or comments about your document.

To create a document address,

1 On a new line in your document, click on the Toolbar.

2 Select Address under Other Paragraph Types, then choose OK.

3 Type the address information you want. For example, you could include your name, e-
mail address, street address, company name, phone number, and so forth.

4 To end the address, press Enter, then click on the Toolbar.

If you would like to preview your document in the Netscape Navigator browser at this point,
see The Mechanics of an HTML Document below.
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The Mechanics of an HTML Document

As you create your HTML document in WordPerfect, you can periodically export it to HTML
format to see how it looks in Netscape.

However, before you export for the first time, you must save your document in
WordPerfect format (see Saving Your Working Document below). This file becomes your
working document—the one you make all your changes to and the one you will save on a
regular basis, just like any other WordPerfect document.

When you export, Internet Publisher will automatically create and save an HTML version of
your working document. This is the version you will view in Netscape and the version your
readers will see when you actually publish it on the WWW.

Saving Your
Working Document

Before you can export your working document to HTML format for the first time, you must
save it in WordPerfect format.

1 Choose Save from the File menu.

2 Specify a path and filename for your working document in the Filename text box. If you
decide to add an extension to the filename, do not use .HTM! This is the file extension
used for your exported HTML document.

3 Choose OK.

Be sure you save your working document on a regular basis.

Exporting Your
Working Document
to HTML Format

Once your working document is saved in WordPerfect format, you can convert the file to
HTML format and see how it appears in Netscape; you do not need to wait until you are
finished creating the document before you can export it.

IMPORTANT: To use the Netscape Navigator browser, at a minimum your computer must
have LAN WorkPlace 4.2 or some other TCP/IP stack and a WINSOCK.DLL installed and
functioning properly on your computer. Please see Recommended Internet Requirements
in the README.TXT file.

1 Click on the Toolbar.

2 If you have exported your working document before, choose Yes to replace the
existing HTML file.

Internet Publisher converts the styles you used in your working document to their
equivalent HTML tags. The exported document is automatically saved with the same path
and filename of the WordPerfect version, along with a .HTM filename extension. Netscape
is then opened and your document is displayed.

3 Close Netscape to return to your working document.

or

Switch back to your working document by holding down the Alt key, then pressing the
Tab key until the name of your working document appears in the box, then releasing
both keys.

If you want to specify a path or filename that is different from the one Internet Publisher
specifies, you can do so by changing the export file path using HTML Preferences. See
Changing the Export File Path later in this section.
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Exporting Your Working Document Without Previewing it in Netscape
You can set up Internet Publisher so that when you export your working document to
HTML format, you do not need to preview it in Netscape.

1 In the Windows Program Manager, choose Run from the File menu.

2 Type the path to your WPIP.INI file in the Command Line text box, then choose OK.
For example, if you did a standard installation of Internet Publisher, the directory path
should be \OFFICE\WPIP\WPIP.INI.

or

Choose Browse, select the WPIP.INI file using the directory, drive, or file lists, then
choose OK twice.

3 Under Main, locate the line that begins with “Preview.”

4 Select the entire text that appears after the equals sign (=).

Selected text

5 Type No in place of the selected text.

6 Choose Exit from the File menu, then choose Yes to save the change.

To always preview your document in Netscape each time you export, repeat the steps
above but change “No” back to “Yes” in step 5.

Changing the Export File Path
Sometimes you may want to specify an export path and filename that is different from the
one Internet Publisher specifies. In such cases, you can use the HTML Preferences
button on the Toolbar to change the default.

1 Click on the Toolbar.

2 Type a new path and/or filename for your exported document in the Export Filename
text box. Make sure you add the HTML file extension (.HTM) to the filename.

3 Choose OK.

The next time you export, the HTML document will be saved in the new location you
specified.

Restoring the Default Export File Path • To restore the option of having Internet
Publisher specify the default export filename and path,

1 Choose HTML Preferences from the HTML menu.

2 Make sure the Export Filename text box is empty, then choose OK.
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Viewing a
Document in
Netscape

Viewing the HTML Tags in Your Document
You can use the Netscape Navigator browser to view the actual HTML tags or “markup”
assigned to the various parts of your document.

1 In WordPerfect, export your working document. For more information, see Exporting
Your Working Document to HTML Format earlier in this document.

2 In Netscape, choose Source from the View menu.

HTML tag

Source view in Netscape

The source view is for read-only purposes. If you would like to edit text you should do so
in your working document in WordPerfect.

3 Choose OK to exit the View Source dialog box.

Viewing an Envoy Document
The Envoy Distributable Viewer that comes with Internet Publisher allows you to see the
contents of an Envoy document (.EVY) that is on the WWW. You do not need the original
Envoy application that created the document to view it. This means you can view not only
a document with its original formatting intact, you can also highlight portions of it, attach
electronic “sticky notes” to it with your comments, and cut and paste sections to the
clipboard (or another application). You can also create hyperlinks from your own
document to an Envoy document on the WWW (see Linking to Other Pages on the
Internet under Creating Hyperlinks later in this document).

When an Envoy document is displayed using Netscape or another browser, you can
access the online Help for further information about using the viewer.

While the Envoy Distributable Viewer allows you to view Envoy documents on the WWW,
you must own an actual copy of the Envoy software if you want to create (or publish) your
own Envoy documents for the WWW. To learn more about Envoy, point your browser to
http://wp.novell.com/npiwp/envoy/envoytoc.htm. Or, to order your own copy of Envoy,
contact your local Novell reseller, or call 1-800-861-2551 within the U.S. and Canada.

Editing an Existing
Working Document

1 In WordPerfect, choose Open from the File menu.

2 In the Filename text box, type the path and filename of your working document, or
select the document using the drive, directory, file, or history lists, then choose OK.

IMPORTANT: Be sure you open the WordPerfect version of your working document. This
is the version you will make changes to. Do not open or make changes to the exported
HTML version (.HTM).

If you accidentally open the HTML version, close the file without saving it and open the
correct version. The next time you export, choose Yes to update any changes you made.
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Editing an Existing
HTML Document

If you are familiar with HTML tags, you can edit an HTML document directly in
WordPerfect, even if it was not created using the Internet Publisher template.

1 In WordPerfect, choose Open from the File menu.

2 In the Filename text box, type the path and filename of the HTML document (.HTM); or,
select the document using the drive, directory, file, or history lists, then choose OK.

3 If the Convert File Format dialog box is displayed, select ASCII (DOS) Text from the
Convert File Format From list box, then choose OK. Otherwise, go to step 4 below.

4 Make the changes you want by editing the text and tags directly in the document.

5 When you are finished, choose Save from the File menu.

6 Select ASCII (DOS) Text from the Format group box, then choose OK.

You can also consider using WordPerfect 6.1 for Windows/SGML Edition. This software is
capable of importing HTML tags produced by another application. To learn more about
WordPerfect 6.1 for Windows/SGML Edition, point your browser to
http://wp.novell.com/npiwp/elecpub/sgmlweb.htm.

Importing an
Existing
WordPerfect
Document into
HTML Format

You can import (or convert) a WordPerfect document (that was not created using the
Internet Publisher template) into HTML format. However, be aware that all formatting
associated with the text is removed.

1 Start a new HTML document. See Selecting the Internet Publisher Template earlier
in this document.

2 In a second document window, open the WordPerfect file that you want to convert to
HTML.

3 Choose Select from the Edit menu, then choose All.

4 Choose Cut or Copy from the Edit menu.

5 Switch to your new HTML document window and place the insertion point where you
want to paste the copied text.

6 Choose Paste Special from the Edit menu.

7 Make sure Paste is selected, then choose Unformatted Text in the list box.

8 Choose OK.

You can now select text and apply the styles you want from the default Internet Publisher
Toolbar.

Advanced Internet Publisher Tasks

This section shows you how to accomplish advanced tasks associated with creating HTML
documents.

See Creating an HTML Document: The Basics for information about common tasks
associated with creating HTML documents.

A collection of sample HTML documents is located in the \WPIP\SAMPLES directory.
These files illustrate some of the capabilities of Internet Publisher. You can modify and
use them as examples for creating your own HTML documents, or you can export them to
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see how the various styles used in the documents appear in Netscape. Be sure you open
only those files with a .WPD extension.

Adding Inline
Graphics Images

Inline graphics are images that appear within the text of your page when it is viewed in
Netscape or another browser. The most widely used graphics formats on the Internet
include the Graphics Interchange Format (.GIF) and the Joint Photographic Experts Group
(.JPG) format. Make sure your images are saved in either of these formats before you use
them in your document. Internet Publisher does not convert graphics images to .GIF or
.JPG format. Therefore, if you add an image that is in WordPerfect Graphics Format
(.WPG), it will not be converted to .GIF or .JPG format when you export to HTML.

1 On a new line in your document, click on the Toolbar.

2 If your image is located in the same directory as your exported HTML document, just
specify the filename in the URL of image text box.

or

If your image is not located in the same directory as your exported HTML document,
specify the path and filename in the URL of image text box.

3 Select an image alignment option.

For a description of each alignment type, in Netscape select How to Create Web
Services from the Help menu located in the upper-right corner of the screen. Click on
Extensions to HTML under Authoring Documents, then scroll down to the <IMG>
list.

4 Type a brief description of the graphics image in the Alternate textual name text box. If
your reader’s browser is unable to display graphics images, this description will appear
in place of the image.

The Ismap option should only be selected when you want to identify an image as an
image map. An image map is a single graphics image that contains two or more different
jumps or links. Selecting this option also requires software development on the HTTP
Web server you are using. Please refer to your server documentation for more
information.

5 If you want, specify the width and height (in pixels) of the graphics image in the Width
and Height text boxes.

This option is useful if you want to speed the display of the page in the browser. When the
height and width are specified, the reader’s browser does not need to wait for the graphics
image to be loaded and its size to be calculated.

6 Choose OK.

Unlike the usual method of adding graphics, an inline image is not physically added to your
working document. Instead, a generic “placeholder” graphic is inserted. When you export
to HTML, the placeholder references the image in the directory you specified in step 2
above and loads it for display in the browser.
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If you want to change the attributes of the image, click once on the placeholder graphic to
select it, then choose Graphic from the HTML menu.

Adding Inline Graphics Images from a Sub-directory
You can create sub-directories for graphics images that are related to your document. For
example, if your exported HTML document were located in a directory called C:\HTML,
you could create a sub-directory called C:\HTML\IMAGES for all your graphics images.
By maintaining them in an easy-to-find location you will find that you can better manage
your working document.

1 In WordPerfect or File Manager, create a sub-directory in the same location where
your exported HTML document is located.

2 Click on the Toolbar.

3 In the URL text box, specify the sub-directory name and the graphics image filename.
For example, if you had an image titled BOAT.GIF, the path might be
IMAGES/BOAT.GIF.

4 Follow steps 3-6 in Adding Inline Graphics Images earlier.

Adding a
Horizontal
Graphics Line

You can use horizontal graphics lines to separate text or graphics images in your
document.

1 On a new line in your document, click on the Toolbar.

Changing the length or thickness of graphics lines will affect their appearance in the
working document only. When you export to HTML, the lines will all be rendered in the
same default length and thickness.

Adding Paragraph
Types

Besides creating paragraphs by simply typing text, you can also apply predefined
paragraph styles. These styles give text a certain appearance in your reader’s browser.

On a new line in your document,

1 Click on the Toolbar, then go to step 2 below.

or

Select the style name of the paragraph type you want from the Styles drop-down list
on the Power Bar, then go to step 4 below. A description of each paragraph type and
its accompanying style name is listed below in Available Paragraph Types.

2 Select the paragraph type you want under Other Paragraph Types. A description of
each paragraph type is listed below in Available Paragraph Types.

The abbreviations to the right of the styles tell you what the actual HTML tag name is when
you view your document source in Netscape (see Viewing the HTML Tags in Your
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Document earlier in this document). If there is no abbreviation, it means the HTML tag
name is identical to the type name.

3 Choose OK.

4 Type your text.

5 When you are finished typing the paragraph, press Enter, then click on the
Toolbar.

You can also select existing paragraph text in your working document and apply the
paragraph type you want.

Available Paragraph Types
Paragraph
Type

Style Name Tag Description

Block Quote block quote <BLOCKQUOTE> Marks text as a left-indented
paragraph. It is typically used
when you are quoting text.

Listing listing <LISTING> Marks text as computer
program source code in your
document. Usually displayed
in a monospaced font such as
Courier.

Preformatted
Text

preformatted <PRE> Renders text exactly as you
have typed it in your working
document. This style gives
you more control over the
formatting of your text. For
example, you can create tables
by using the space bar to align
columns of information. Text
with this style applied is usually
displayed in a monospaced
font such as Courier and any
soft or hard returns in your
working document are
converted to hard returns when
you export to HTML.

Example example
HTML

<XMP> Functions just like the
Preformatted Text type.
However, any HTML tags that
you type within this style in
your working document are not
recognized as actual tags
when you export to HTML.

Force Line
Break

line break <BR> Paragraphs in an HTML
document are usually
displayed with a blank line
before and after them. You
can, however, force a
sentence or paragraph that
immediately follows a line
break style onto the next line,
without the addition of a blank
line. This is sometimes known
as a simple line break and is
commonly used within the
Address style.
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Paragraph
Type

Style Name Tag Description

Address address <ADDRESS> Marks text as an Internet
address, street address, a list
of authors, phone number, and
so forth. Usually displayed in
italics.

Plain <P> Text is plain, with no styles
applied.

Adding Character
Styles

You can use character styles to change the appearance of words or characters in your
document. When you apply a character style to text you have the choice of using either a
logical style or a physical style.

An applied logical character style gives text a special meaning for the way it is emphasized
or highlighted in a browser. For example, certain logical styles can be used to mark text as
a citation, as computer program code, or as a definition. It is then left up to your reader’s
browser to decide what kind of emphasis should be placed on the text based on the logical
style you used and the recommendations of the HTML 2.0 specification (point your
browser to http://hopf.math.nwu.edu/html2.0/ for HTML 2.0 information).

An applied physical character style will attempt to render the text in a browser using the
physical attribute you specify, such as Bold, Italics, or Monospaced. Beware, however,
that using this type of style is entirely subject to the capabilities of your reader’s browser.
For example, a character-based browser may not be able to display certain physical styles
in your document as you wanted them to appear (a bold style and an italics style may both
appear underlined instead). For this reason, you should use an equivalent logical
character style whenever possible, since these indicate how the text should be used or
highlighted in your document, not how it should be displayed in a browser.

1 Select the text that you want a character style applied to.

2 Click on the Toolbar, then go to step 3 below.

or

Select the style name of the character style you want from the Styles drop-down list on
the Power Bar. You do not need to finish the remaining steps. A description of each
character style and its accompanying style name is listed below in Available Character
Styles.

3 Select the physical style or logical style you want. A description of each style is listed
below in Available Character Styles.

The abbreviations to the right of the styles tell you what the actual HTML tag name is when
you view the source of your document in Netscape (see Viewing the HTML Tags in Your
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Document earlier in this document). If there is no abbreviation, it means the HTML tag
name is identical to the style name.

4 Choose OK.

IMPORTANT: To remove a character style from text, you must drag the character style
code out of the Reveal Codes area.

Available Character Styles
Physical Style Style Name Tag Description

Bold WordPerfect bold
attribute

<B> Marks text that is bold.
Depending on the
capabilities of your
reader’s browser, bold text
may appear underlined
instead.

Italic WordPerfect italic
attribute

<I> Marks text that is
italicized. Depending on
the capabilities of your
reader’s browser, italic text
may appear underlined
instead.

Underline WordPerfect
underline attribute

<U> Marks text that is
underlined. This attribute
is not understood by most
browsers.

Monospaced monospaced <TT> Marks text that uses the
same amount of horizontal
space for each character
(for example, an i takes up
as much horizontal space
as a w). Courier is an
example of a monospaced
font.

Blink blink <BLINK> Marks text that flashes on
and off.

Logical Style Style Name Tag Description

Citation citation <CITE> Marks text as a citation,
acknowledgement, or a
“footnote” in your
document. Usually
displayed in italics.

Code code <CODE> Marks text as an example
of typed computer code.
Usually displayed in a
monospaced font such as
Courier.

Definition definition <DFN> Marks text as a definition.
Usually displayed in italics
or bold italics. This style is
not understood by most
browsers.

Emphasized emphasized <EM> Marks text as emphasized.
Usually displayed in italics.
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Physical Style Style Name Tag Description

Keyboard Key keyboard key <KBD> Marks text as keyboard
input from the reader. For
example, “Press Enter or
Alt.” Usually displayed in
a monospaced font such
as Courier.

Sample sample <SAMP> Marks text as a sequence
of literal characters, such
as computer program
code.
Usually displayed in a
monospaced font such as
Courier.

Strong strong <STRONG> Marks text with a strong
emphasis. Usually
displayed in bold.

Variable variable <VAR> Marks text as a variable
name. Usually displayed
in italics or bold italics.

Special Style Style Name Tag Description

Literal HTML literal HTML None Lets you include HTML
tags in your document that
are exported and
recognized in the browser.
For more information on
using Literal HTML, see
Adding HTML Tags
Directly to a Working
Document later in this
document.

Adding Characters
and Symbols

In addition to using the characters and symbols on your keyboard, you can insert
multinational characters and typographic symbols into your document.

1 Place the insertion point where you want the character to appear in your text, then
choose Character from the Insert menu.

HINT: You can also open the WordPerfect Characters dialog box by pressing Ctrl+W.

Choose the Multinational

character set from this pop-up

list

Selected character

Character number

2 Choose Multinational or Typographic Symbols from the Character Set pop-up list.

In the Multinational character set, numbers 23 to 89 are supported by the Netscape
browser (excluding character numbers 24, 25, 74, 78, and 79).

To see all the extended characters and symbols supported by the Netscape browser, see
Appendix A: Supported Characters and Symbols.
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3 Select the character you want.

4 Choose Insert and Close.

or

Choose Insert, then select another character.

You should be aware that certain characters and symbols may not be seen by your reader.
This is because some browsers have only limited support for the display of multinational
extended characters and typographic symbols.

Adding HTML
Tags Directly to a
Working Document

Normally, when you create your HTML document with Internet Publisher, you are simply
adding styles from the Toolbar and typing your text. When you export your working
document, these styles are converted to actual HTML tags. You can view these tags in
Netscape (see Viewing the HTML Tags in Your Document earlier in this document) to see
how they look.

Sometimes, however, there may be instances when you want to include HTML tags in your
working document because they are not available on the Toolbar. In such cases, you can
use the Literal HTML style to type the actual tag syntax into your document.

1 Place the insertion point where you want the start tag to appear, then click on the
Toolbar.

2 Select Literal HTML under Special Style, then choose OK.

An HTML tag added directly to

the working document

3 Type the opening tag syntax, the body text, and the closing tag syntax. The double-
underline attribute indicates that the Literal HTML style is being used.

If you want to use multinational or typographic characters within the Literal HTML style,
you can either insert the desired character from the WordPerfect Characters dialog box, or
you can type the character’s entity reference. For a list of entity references, see
Appendix A: Supported Characters and Symbols.

4 To end the style, click on the Toolbar.

Sometimes you may want to use HTML tags in your document to show a reader how they
are typed, but you do not want them recognized as actual HTML tags when you exported
your document. In such cases, just type the tag syntax as you would plain text (no styles
applied).
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Creating Hyperlinks

You can enhance the versatility of your HTML documents by using bookmarks and
Uniform Resource Locators (URLs) to create anchors or “hyperlinks.” Hyperlinks, when
activated, move you to other information sources either in your current document or in
other areas on the Internet.

For tips on using URLs, see Appendix B: Publishing Your Document on the WWW.

Linking to Other
Pages on the
Internet

You can create links in your document to virtually any other information area on the
Internet (including Envoy [.EVY] documents) that has public access.

1 Select the text that marks the location you will jump from in your document to the target
location of the document on the Internet.

2 Click on the Toolbar.

3 Type the URL address of the Internet document in the Text of URL text box.

You can change the default URL that appears in the Text of URL text box by editing the
WPIP.INI file in Windows Notepad. See Changing the Default URL later in this document.

4 Choose OK.

Linking to a
Specific Location in
Your Current
Document

You can use the Bookmark feature in WordPerfect to mark a section in your document that
a reader can jump to quickly. This is particularly helpful in long documents because it
saves a reader from frequently scrolling to find the information they need.

1 Move the insertion point to a place that marks the target location you will jump to in
your document.

or

Select the text that marks the target location you will jump to in your document.

2 Click on the Toolbar, then choose Create.

The Bookmark Name text box contains a sample of the text that immediately follows the
insertion point or the text that you have selected. The text may contain words that will help
you identify the location of the bookmark. If not, you can specify another name for the
bookmark.

3 Choose OK.

or

Type a name for the bookmark, then choose OK.
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4 Move the insertion point to a place that marks the location you will jump from in your
document to the target location.

or

Select the text that marks the location you will jump from in your document to the target
location.

5 Click on the Toolbar.

6 Make sure that the URL text box is empty, then type the name of the bookmark from
step 2 above in the Bookmark Name text box.

7 Choose OK.

Editing a Hypertext Link
To edit the hypertext link from step 4 above,

1 Click inside the underlined word.

2 If you are prompted to save your document choose Yes, otherwise choose OK.

3 Choose Hypertext Link from the HTML menu.

Linking to a
Specific Location in
Another Document

You can add a bookmark in another HTML document you create, or in an existing Envoy
document (.EVY), then build a link to it from your current working document.

1 Open a second working document in WordPerfect (see Editing an Existing Working
Document earlier).

2 Move the insertion point to a place that marks the target location you will jump to in
your document.

or

Select the text that marks the target location you will jump to from your current working
document.

3 Click on the Toolbar, then choose Create.

The Bookmark Name text box contains a sample of the text that immediately follows the
insertion point or the text that you have selected. The text may contain words that will help
you identify the location of the bookmark. If not, you can specify another name for the
bookmark.
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4 Choose OK.

or

Type a name for the bookmark, then choose OK.

5 In the current working document, move the insertion point to a place that marks the
location you will jump from in your document to the target location.

or

In the current working document, select the text that marks the location you will jump
from to the target location.

6 Click on the Toolbar.

7 In the URL text box, type the path, filename, and extension of the second document
(the extension can be .HTM for an HTML document or .EVY for an Envoy document),
then type the name of the bookmark from step 2 above in the Bookmark Name
(optional) text box.

You can change the default URL that appears in the Text of URL text box by editing the
WPIP.INI file in Windows Notepad. See Changing the Default URL below.

8 Choose OK.

Changing the Default URL

1 In the Windows Program Manager, choose Run from the File menu.

2 Type the path to your WPIP.INI file in the Command Line text box, then choose OK.
For example, if you did a standard installation of Internet Publisher, the directory path
should \OFFICE\WPIP\WPIP.INI.

or

Choose Browse, select the WPIP.INI file using the directory, drive, or file lists, then
choose OK twice.

3 Under Main, locate the line that begins with “DefaultURL.”

4 Select the entire URL address that appears after the equals sign (=).

Selected URL address

5 Type the new default URL address.

6 Choose Exit from the File menu, then choose Yes to save the change.

Linking an Inline
Graphics Image to
Another HTML
Document

You can turn an inline graphics image into a “button” that a reader can click to jump to
another page.

1 Place the insertion point where you want the linked image to appear, then click on
the Toolbar.

2 In the Text of URL text box, type the URL address of the page your reader will jump to
from your document, then choose OK.
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You can change the default URL that appears in the Text of URL text box by editing the
WPIP.INI file in Windows Notepad. See Changing the Default URL earlier in this
document.

3 Click on the Toolbar, then specify the filename of the graphics image. Make sure
your graphics file is located in the same directory as your exported HTML document.

4 Select an image alignment option.

For a description of each alignment type, in Netscape select How to Create Web
Services from the Help menu. Click on Extensions to HTML under the Authoring
Documents heading, then scroll down to the <IMG> list.

5 Type a brief description of the graphics image in the Alternate Textual Name text box.
If your reader’s browser is unable to display graphics images, this text will be used in
place of the image.

The Ismap option should only be selected when you want to identify an image as an
image map. An image map is a single graphics image that contains two or more different
jumps or links. Selecting this option also requires software development on the HTTP
Web server you are using. Please refer to your server documentation for more
information.

6 If you want, specify the height and width (in pixels) of the graphics image in the Width
and Height text boxes. This option is useful if you want to speed the display of the
page in the browser. When the height and width are specified, the reader’s browser
does not need to wait for the graphics image to be loaded and its size to be calculated.

7 When you are finished, choose OK.

Editing a URL Address of an Image
To edit the URL address of the linked “image” in your working document,

1 Move the insertion point to the immediate left of the placeholder graphic (do not select
the graphic), then choose Hypertext Link from the HTML menu.

Editing the Placement of an Image
To edit the placement of an image,

1 Select the placeholder graphic, then choose Graphic from the HTML menu.

Linking an Inline
Graphics Image to
an External
Graphics Image

Sometimes the use of a large inline graphics image can take a while to display in your
reader’s browser. One way to avoid this is by linking a miniature version or “thumbnail” of
a graphics image in your working document to the full-size version in another document.

The thumbnail simply gives your reader a small, fast display of the image. The reader can
then decide if they want to click it to view the full-size version.

1 Place the insertion point where you want the linked image to appear, then click on
the Toolbar.

2 In the Text of URL text box, type the URL address of the second HTML document
(which contains the full-size image) your reader will jump to from your document, then
choose OK.

Generally, it is best to have the second working document that contains the full-size image
stored in a sub-directory of your primary working document.

3 Click on the Toolbar, then specify the filename of the graphics image. Make sure
your graphics file is located in the same directory as your exported HTML document.

4 Specify the width and height (in pixels) of the graphics image in the Width and Height
text boxes.
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The pixel dimension you decide on should reduce your image to about the size of a
postage stamp or slightly larger.

5 Choose OK.

Editing a URL Address of an Image
To edit the URL address of the linked “image” in your working document,

1 Move the insertion point to the immediate left of the placeholder graphic (do not select
the graphic), then choose Hypertext Link from the HTML menu.

Editing the Placement of an Image
To edit the placement of an image,

1 Select the placeholder graphic, then choose Graphic from the HTML menu.

Where to Go to
Learn More

For information on publishing your document, please see Appendix B: Publishing Your
Document on the WWW.

To learn about Netscape menu items,

1 In Netscape, choose Handbook from the Help menu, then click Menu items in the
Reference section (you may need to scroll down to see Menu items).

For a Netscape tutorial,

1 In Netscape, choose Handbook from the Help menu, then click on Learn Netscape in
the Tutorial section (you may need to scroll down to see Learn Netscape).

To learn more about the Internet,

1 In Netscape, choose About the Internet from the Directory menu.

To learn about Internet jargon and acronyms,

1 In Netscape, type http://curia.ucc.ie/info/net/acronyms/acro.html in the Location
text box, then press Enter.
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Appendix A: Supported Characters and Symbols

The following information describes the international characters that are supported in the
HTML 2.0 specification and in Netscape. The typographic symbols listed below the
international character list are supported in Netscape only. For further information on
adding these characters to your document, see Adding Characters and Symbols under
Advanced Internet Publisher Tasks.

If you want to use multinational or typographic characters within the Literal HTML style,
you can either insert the desired character from the WordPerfect Characters dialog box, or
you can type the character’s entity reference as listed below. For more information on
using the Literal HTML style, see Adding HTML Tags Directly to a Working Document
under Advanced Internet Publisher Tasks.

Multinational
Character Set

Character WP Character
Number

Entity
Reference

Description

ß 1,23 &szlig; Lowercase sharp s, German

Á 1,26 &Aacute; Uppercase A, acute accent

á 1,27 &aacute; Lowercase a, acute accent

Â 1,28 &Acirc; Uppercase A, circumflex accent

â 1,29 &acirc; Lowercase a, circumflex accent

Ä 1,30 &Auml; Uppercase A, umlaut mark

ä 1,31 &auml; Lowercase a, umlaut mark

À 1,32 &Agrave; Uppercase A, grave accent

à 1,33 &agrave; Lowercase a, grave accent

Å 1,34 &Aring; Uppercase A, ring above

å 1,35 &aring; Lowercase A, ring above

Æ 1,36 &AElig; Uppercase AE, ligature

æ 1,37 &aelig; Lowercase ae, ligature

Ç 1,38 &Ccedil; Uppercase C, cedilla

ç 1,39 &ccedil; Lowercase c, cedilla

É 1,40 &Eacute; Uppercase E, acute accent

é 1,41 &eacute; Lowercase e, acute accent

Ê 1,42 &Ecirc; Uppercase E, circumflex accent

ê 1,43 &ecirc; Lowercase e, circumflex accent

Ë 1,44 &Euml; Uppercase E, umlaut mark

ë 1,45 &euml; Lowercase e, umlaut mark

È 1,46 &Egrave; Uppercase E, grave accent

è 1,47 &egrave; Lowercase e, grave accent

Í 1,48 &Iacute; Uppercase I, acute accent

í 1,49 &iacute; Lowercase i, acute accent

Î 1,50 &Icirc; Uppercase I, circumflex accent

î 1,51 &icirc; Lowercase i, circumflex accent

Ï 1,52 &Iuml; Uppercase I, umlaut mark

ï 1,53 &iuml; Lowercase i, umlaut mark

Ì 1,54 &Igrave; Uppercase I, grave accent

ì 1,55 &igrave; Lowercase i, grave accent

Ñ 1,56 &Ntilde; Uppercase N, tilde
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Character WP Character
Number

Entity
Reference

Description

ñ 1,57 &ntilde; Lowercase n, tilde

Ó 1,58 &Oacute; Uppercase O, acute accent

ó 1,59 &oacute; Lowercase o, acute accent

Ô 1,60 &Ocirc; Uppercase O, circumflex accent

ô 1,61 &ocirc; Lowercase o, circumflex accent

Ö 1,62 &Ouml; Uppercase O, umlaut mark

ö 1,63 &ouml; Lowercase o, umlaut mark

Ò 1,64 &Ograve; Uppercase O, grave accent

ò 1,65 &ograve; Lowercase o, grave accent

Ú 1,66 &Uacute; Uppercase U, acute accent

ú 1,67 &uacute; Lowercase u, acute accent

Û 1,68 &Ucirc; Uppercase U, circumflex accent

û 1,69 &ucirc; Lowercase u, circumflex accent

Ü 1,70 &Uuml; Uppercase U, umlaut mark

ü 1,71 &uuml; Lowercase u, umlaut mark

Ù 1,72 &Ugrave; Uppercase U, grave accent

ù 1,73 &ugrave; Lowercase u, grave accent

ÿ 1,75 &yuml; Lowercase y, umlaut mark

Ã 1,76 &Atilde; Uppercase A, tilde

ã 1,77 &atilde; Lowercase a, tilde

Ø 1,80 &Oslash; Uppercase O, slash

ø 1,81 &oslash; Lowercase o, slash

Õ 1,82 &Otilde; Uppercase O, tilde

õ 1,83 &otilde; Lowercase o, tilde

Ý 1,84 &Yacute; Uppercase Y, acute accent

ý 1,85 &yacute; Lowercase y, acute accent

Ð 1,86 &ETH; Uppercase Eth, Icelandic

ð 1,87 &eth; Lowercase eth, Icelandic

Þ 1,88 &THORN; Uppercase THORN, Icelandic

þ 1,89 &thorn; Lowercase thorn, Icelandic

Typographic
Symbols Character
Set

The entity references are specific to Netscape.

Character WP Character Entity Description

© 4,23 &copy; Copyright sign
® 4,22 &reg; Registered sign
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Appendix B: Publishing Your HTML Document on the
WWW

HTML documents can be created with WordPerfect Internet Publisher and previewed with
Netscape. However, to publish them so that others can read them on the Internet, you
must use a WWW server, also known as an HTTP (HyperText Transport Protocol) server.
HTTP servers are available for many platforms, including varieties of UNIX, Apple
Macintosh, and Windows.

An HTTP server must be a machine with an Internet domain name, such as
www.novell.com. The domain name of the server is part of the address of documents on
that server. Generally, the documents on an HTTP server are located in a subdirectory of
the file system, often called the "document root" directory. All documents in the document
root directory and any of its subdirectories can be retrieved from the HTTP server and
displayed by a browser such as Netscape Navigator.

A document is published on an HTTP server by placing it in the document root directory or
one of its subdirectories. This process depends on the operating system of the server.
For example, if the server uses the UNIX operating system, you will typically have to use a
file transfer program such as ftp to copy the HTML documents from your computer to the
UNIX machine. In any case, you will need to get specific instructions on publishing from
the administrator of the HTTP server.

You also may want to ask your system administrator how to limit access to any confidential
documents. Many HTTP servers provide ways to limit document access only to those who
have passwords for those documents.

Document
Addressing

Once your document has been placed on the server, you need to let readers know how to
find it. The simplest way to do this is to include a hyperlink to it from another document.
The hyperlink is in the form of an address called a World Wide Web Uniform Resource
Locator, or URL, which points to your document. There are many varieties of URLs (this
appendix, however, will only address a type that is adequate for simple electronic
publishing). An example of a full or "fully qualified" URL address is the following:

http://www.mycompany.com/somedir/mydoc.html

In the example above, the syntax http: is the name of the protocol (in this case, HTTP)
used to transmit requests from the browser to the server, and to return the document from
the server to the browser.

The syntax //www.mycompany.com is the Internet domain name of the HTTP server.
Double slashes always precede an Internet domain name. The syntax
/somedir/mydoc.html is the location to the desired document from the document root of
the server.

The document root is usually not the actual root of the file system. In other words,
/somedir/mydoc.html is not the full pathname of the document within the server's file
system. Rather, the full pathname would be the document path linked to the end of the
document root path. For example, if the document root were /usr/local/www and the
document location were /somedir/mydoc.html, then the full pathname of the document
would be /usr/local/www/somedir/mydoc.html in the server's file system.

While you need to know this full path name when placing your own documents on a
server, you should only use the last part of the URL path when creating links to your
document.
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Using Different
Types of URLs

Since there is no standard terminology for describing the different types of URLs, the terms
Type I, Type II, and Type III will be used, as in the following examples:

Type URL

I http://www.site.com/line/prod1/doc1.html, http://www.novell.com
II /line/prod2/part1/doc.html, /401k/intro.html
III ../part2/doc1.html, doc2.html

Knowing how and when to use these different types of URLs is important because it has
an impact on how difficult it is to maintain the documents on the server. Hyperlinks that
contain a URL have a tendency to be “fragile.” That is, some kinds of changes to a
collection of documents on a server can cause some hyperlinks to “break.”

A hyperlink breaks when the URL points to a document that no longer exists. For
example, if you have a document that is using a Type I URL, such as
http://www.site.com/line/prod1/doc1.html, and you change the name of the document from
doc1.html to intro.html, then all hyperlinks that refer to the document by its old name will
break. If a reader clicks on the broken hyperlink, an error message displays. Selecting
the right kind of URL for different situations will help reduce such problems and will also
help you easily maintain your collection of documents on the server.

One concept that may help you choose the right kind of URL is that of a "collection" of
documents. A "collection" in this sense, is a set of related documents that are maintained
together as a unit. Several different collections of documents could exist on the same
server. For example, if a server has documents for several different departments on it,
then each department's documents make up a separate collection.

When to Use a Type I URL
Always use a Type I URL when referring to a document on another server because it is the
only kind of URL that provides a place for the name of the other server. This is the only
scenario in which a Type I URL should be used. If you use a Type I URL in a document on
a server to refer to another document on the same server, and the name of the server
changes, then the hyperlink will break.

When to Use a Type II URL
Type II URLs do not begin with http: and the name of the server, but they do begin with a
single forward slash (/). The single forward slash tells the browser that the path to the
referenced document begins at the document root of the same server that the current
document came from.

Type II URLs should be used when referring to documents on the same server, but in a
different collection. For example, suppose you are writing a document about policies and
procedures for the purchasing department and you need to refer to a document that is
maintained by the accounting department. Both documents are on the business
department server. In this case, you would use a Type II URL, since you are referring to a
document in a different collection. Using a Type II URL means that you will not need to
revise the hyperlink, even if you reorganize your collection of documents.

Type II URLs are often used to refer to graphics images that are stored in a separate
directory. For example, if you have a graphic file, logo.gif, that contains your company
logo, you could place it in a subdirectory of the document root called "images". You could
then refer to the logo as /images/logo.gif from any document in any collection on the entire
server.

When to Use a Type III URL
Type III URLs always begin with the name of a file, the name of a directory, or two dots (..).

Use a Type III URL when you want to refer to other documents in the same collection.
Using Type III URLs reduces the necessity to edit hyperlinks when a document collection
is reorganized. As long as a set of documents are moved together, any hyperlinks among
them will not have to be edited.
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Type III URLs are "relative," meaning that the document referred to by the URL is found by
following a path from the directory of the current document. Each component of the URL
is a step in the path from the current directory to the referenced document.

For example, suppose you are editing the document
http://www.site.com/line/prod1/doc1.html, and you want to refer to the document doc2.html
in the same directory. You could use a Type II URL, and refer to it as
/line/prod1/doc2.html. However, if you had to put all of the "line" documents in a new
subdirectory to make room for another collection of documents on the same server (for
example, http://www.site.com/line/prod1/doc2.html would become
http://www.site.com/marketing/line/prod1/doc2.html), then the link would break. If you use
the Type III URL doc2.html instead, then this type of change would have no impact on the
hyperlink.

Two dots (..) are used to refer to a directory that is one level higher in the directory tree.
For example, to refer to http://www.site.com/line/prod2/intro.html from
http://www.site.com/line/prod1/doc1.html, use the Type III URL ../prod2/intro.html.

It is quite common to have a file which serves as an index to documents which are in
separate subdirectories. Let's say that you are creating such an index file to three
documents: file1.htm, file2.htm, and file3.htm, each in their own subdirectory dir1, dir2, and
dir3 respectively. In this case, you would want your three URLs to read as follows:

dir1/file1.htm
dir2/file2.htm
dir3/file3.htm

Additional
Publishing
Information for
HTML Documents

Always use forward slashes (/) in URLs, and never backslashes (\). Backslashes are used
in DOS and Windows filenames.

URLs may be case sensitive, depending on the operating system used on the server.
UNIX servers, in particular, are typically case sensitive, so
http://www.site.com/line/prod1/doc1.html and http://www.site.com/line/Prod1/DOC1.html
are not the same. It is often most convenient in the long run to keep file and directory
names in all lower case. In some cases this makes it easier to transfer documents
between the server and your computer, and it is often easier on those who read the
documents later.

If you make sure that the server you use recognizes document filenames that end in the
.HTM extension, it will be much easier to maintain HTML documents created with Internet
Publisher. By default, many servers recognize documents with the .HTML extension as
HTML documents. However, since Internet Publisher only permits three character
extensions, the .HTM extension is used. When a document, such as mydoc.htm, is placed
on a server, you can then rename it to mydoc.html if you prefer. However, it is much
simpler if the server simply recognizes that mydoc.htm as an HTML file. This, however,
depends on the particular server. Some servers use a file called mime.types in the
configuration directory to control the mapping between file extensions and document
types. For example, you would edit the line:

text/html html

to read

text/html html htm

You may want to discuss this issue with the system administrator of your HTTP server.
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Publishing
WordPerfect and
Envoy Documents

In order to publish Envoy documents on your HTTP server, you need to make sure that
there is an entry for the Envoy document type in the document type configuration file. As
described earlier, this configuration file is often called mime.types. Specifically, you must
ensure that the server knows that files that end in the extension ".evy" are of type
"application/envoy". The configuration file may need a line that is similar to the following:

application/envoy evy

Once the server properly recognizes Envoy documents, those files can be published
simply by placing them on the server. There is no need to perform any conversion of any
type on them.

When the WordPerfect viewer is available, WordPerfect documents can be published in
the same way, provided a WordPerfect entry is made in the server's type table. The entry
may appear as the following:

application/wordperfect wpd

You can substitute some other extension for .WPD if you do not use .WPD as the
extension for WordPerfect files. Depending on the server, you may also be able to register
several extensions for WordPerfect files. Remember that most servers recognize
document types by extension only, so all WordPerfect documents will have to end in one
of the default WordPerfect extensions.

Some servers may have an entry for the type application/wordperfect5.1. These entries
are best ignored since, at this time, no viewers for WordPerfect 5.1 are available in a form
that can be integrated with a WWW browser such as Netscape.

Appendix C: Novell Technical Services

WordPerfect Internet Publisher is a free add-on to WordPerfect 6.1 for Windows.
Technical support options for the components of Internet Publisher are as follows:

Netscape Navigator Help documents for Netscape Navigator are available from Netscape's Help menu.
Additional help is available from Novell's Internet Publisher Home Page at
http://wp.novell.com/elecpub/intpub.htm.

Fee-based support for Netscape Navigator is available from Netscape Communications
Corporation by choosing How to Get Support from the Help menu in Netscape. Novell
does not provide call-in support for the Netscape Navigator component of WordPerfect
Internet Publisher.

WordPerfect
HTML Template

If you are in the United States, U.S. Territories, or Canada and you need assistance
beyond what the online Help can provide, you can call the numbers listed below for
personalized help with the WordPerfect HTML template.

• (900) 555-6040 Pay per Call Support (you will be charged for the call in addition to
$2.00 per minute for support service)

• (800) 861-2445 $25.00 per incident

Support engineers are available every day, 24 hours a day, excluding U.S. holidays.
WordPerfect Internet Publisher support policies are subject to change without prior notice.
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Envoy
Distributable
Viewer

If you are in the United States, U.S. Territories, or Canada and you need assistance
beyond what online Help can provide, you can call the numbers listed below for
personalized help with the Envoy Distributable Viewer.

• (900) 555-7373 Pay per Call Support (you will be charged for the call in addition to
$2.00 per minute for support service)

Support engineers are available every day, 24 hours a day, excluding U.S. holidays.
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creating 19
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Monospaced, character style 28
More information about Internet 35
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adding to documents 29
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Click a letter above for easy access to the index.

Once you are in the index, press Ctrl+G and enter the page number of the
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Using ENVO Y

N AV I G ATING SEARCH 

Go to first page

Go to last page (you are on
the last page now)

Go to next page

Go to previous page

Go to next view

Go to previous view

Go to page (Ctrl+G)

ONLINE HELP

BLUE TEXT

Click blue text to go to a new location
in the document.

F3 Find Next
Ctrl+F3 Find Previous

A complete Help system with
detailed information is just waiting
for you to explore!

It includes the following sections:

Contents: How Do I... Search
Additional Help Using Help


